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1. New Layout.  Yeah, it looks pretty different, but all the stuff you remember is still in there.  Now
everything's inside one big window.

2. Piano Roll.  Now you can compose full polyphonic melodies without having to use multiple patterns.
Plus, the Piano Roll contains support for note slides (pitch bending) and arpeggios!  See the Piano Roll
section of this guide and the on-line help for more info.

3. Synth Plugins Now Supported. Now you can download synthesizer plugins and use them live right in
your song.  Plus there's an awesome new array of synths built right in! See the Generators section of
this guide and the on-line help for more info.

4. Events Now Stored in Patterns. In previous releases, you only had one global track of events.  Every
control had one Event Editor only.  Now every control has one Event Editor per pattern, and you have
to drop a pattern into the playlist to get the events on that pattern to take effect.  This could cause some
confusion, so you better take some time to wrap your head around it.  The big advantage is that you
can now set up the effect changes you want and then repeat them or move them around in the song.
See the Live Recording section of this guide and the on-line help for more info.

5. New FX Tracks.  There are now 16 FX Tracks instead of 8, but even better, there are 2 new Send FX
Tracks.  Now you can put the same reverb on two different FX Tracks without having to use the reverb
plugin twice.  See the Fruity Effects section of this guide and the on-line help for more info.

6. Plus Much Much More. Check out the WhatsNew.doc in the main Fruity Loops directory for a brief
run down of what else is new.
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(web address).  The e-mail will also contain a Registration Key file with a strange name and a ".key"
extension.

2. Go to the Web Site.  Use the WebLogin link to get to the Fruity Loops 3 web site.  You will be
automatically registered on the site and you'll be sent to the "News" page shown below.

3. Download the Installation Program.  In the "My Fruityloops" section of the page (indicated by the
arrow above) you should see your personal link to download the Fruity Loops 3 installation program.
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5. Save the Registration Key.  Go back to the e-mail and save the ".key" file to the same folder you just
installed Fruity Loops to.

6. Register Fruity Loops 3.  Surf to the Fruity Loops 3 directory, and double-click the ".key" file you
just saved there.  You should get a message saying that your Windows registry has been updated.  If it
doesn't seem to work, rename the file to give it a ".reg" extension and try again.

7. Run the Program. Go to Start →→→→ Programs →→→→ Fruity Loops 3 and run Fruity Loops!

8. Bookmark the Web Site.  The Fruity Loops web site is an awesome resource.  Check back at
www.fruityloops.com often to see what's up.

9. Read this Guide.  As soon as you start Fruity, you'll be confronted with strange dialog boxes and
messages.  Proceed to the next section of this guide to find out what to do next.

http://www.fruityloops.com/
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1. The Environment Settings Screen. When you first run Fruity loops, you may be confronted with a
dialog box like the one below.  You just have to use the select boxes to choose your sound card and
MIDI drivers.  At first, you'll be looking at the MIDI screen, but for now the most important one is the
WAVE screen, shown below.

2. Select an Output Driver from the list in the pull-down menu.  If you don't know which one to pick,
just leave it as it is.  Later on if you have sound problems, you can come back to this screen (by
pressing F10) and experiment with the other options.

3. The Mixing Buffer.  When you mouse over the buttons on the above screen, you'll get a pop-up
explanation of each one except the Mixing Buffer. So we'll explain that here. Basically, if you make
this buffer long, you are less likely to get choppy sound but changes you make to a playing loop will
take longer to kick in.  If you make it short, you are more likely to get choppy sound but changes will
kick in faster.  You want it short, but depending on your computer, you may need to come back to this
screen later (F10) and make it longer.  If you have a combination of a fast computer and a good sound
card, you may be able to get the latency as low as 10ms.  For a SoundBlaster Live, you can probably
go as low as 30ms.  The Use Polling option can also improve latencies.  Keep it turned on if you use
Windows 95 or 98, but switch it off in Windows 2000.

Click Here

Then Here
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MMAAKKEE  SSOOMMEE  NNOOIISSEE

Press the Play Switch.  That's the button the finger is pointing at on the above picture.  You'll hear the
hyperactive sounds of the Fruity Loops 3 demo loop.  If this is not the first time you've run Fruity, you'll
have to reload this demo.  Select Open from the File menu in the top left and double click the file
NewStuff.flp in the Loops directory.

Master Volume: It's the vertical slider just to the right
of the menu bar and to the left of the play switch.
This will be essential if you still live with your parents.
(Get a life! …or at least get some headphones…)

Step
Sequencer
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1. The Hint Bar. This is located on the Main Window just under the Menu Bar (see the previous page,
where it says "Start/Pause" in the top left).  You can mouse over any of the controls within the Main
Window and this panel will display a short description of what that control does.  The reason it says
"Start/Pause" in the picture is because the mouse is over the Start/Pause button.  Make sense?  The
Hint Bar also shows you the Shortcut Key that will activate the same function.  This is displayed on
the right, where it says "Space" on the previous picture.  Pressing this key has the same effect as
pressing the corresponding button.

2. On-line Help.  Fruity Loops also comes with a massive on-line help reference created by Stanislav
Vasilev from mmlabs.  Just use the Help Menu and select Contents.  It's all there, in glorious
Technicolor (we were way too cheap to print this guide in color.)

3. Tutorial Loops.  Click File→→→→Open and surf to the Tutorials directory.  These loops contain notes on
how to do various things in Fruity.

4. The Web Site.  Fruity Loops comes with a massive web site at www.fruityloops.com.  The site has a
support section that includes a FAQ and a Discussion Forum.  Check both of those to see if anyone
has answered your questions already.  If not, feel free to post your own question.

GGEETT  TTHHEE  ""GGEETTTTIINNGG  SSTTAARRTTEEDD""  LLOOOOPPSS

To use this guide effectively, you should find and load the "Getting Started" loops that were included in the
Fruity package.  Go to the File menu (above the Hint Bar) and click on Open.  Alternatively, click on the
File Open Icon below the Hint Bar.  Either method will get you a file dialog box open on the Loops
Directory.  From here, double-click the Tutorials Subdirectory, then the Getting Started Subdirectory
and you will see the Getting Started Loops.  Load up the first one (GettingStarted1.flp), press Play and
move on to the next section!

HEY! Don't skip that step.  This guide
will work a lot better if you're looking at
the example loops while you read…

http://www.fruityloops.com/


  
11

1. What You're Lookin' At. This is where you find channels, and dots.  The channels are laid out
horizontally (see below) and each one contains a single sound.  Each channel has 16 dots.  If you're
musically inclined, these dots represent 16th notes.  If not, think of each group of four dots as one beat,
so 16 dots are the four beats of a basic drum loop.  (The layout below is from GettingStarted1.flp.
You should have this loop loaded now.)

2. What Dots are For.  Clicking on a dot lights it up and tells Fruity to trigger the channel (play the
sound loaded into that channel) at that point in the loop.  For instance, the 1st, 5th, 9th, and 13th dots in
the C_Kick channel are lit up, telling Fruity to play the kick drum sound four times during the loop (if
you're still thinking of groups of four dots as a single beat, Fruity Loops will play the sound at the start
of each beat.)  Try changing the pattern of dots in the C_Kick channel. (If you need to turn a dot off,
right-click it.)  Once you've got the dots to light up like the picture below, press the play switch to hear
what you've created.

Some
Dots

A Channel

A Channel
Name

Suggested
Changes

Channel
Controls
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4. Make Your Own Beat. Don't like the beat above?  Good, make your own!  Only, don't change the
Ins_Round sample for now - it's playing the melody and you need to know more before you can mess
with that. In the next sections, we'll teach you how to load in new samples, set up melodies, and
change the sound of each channel (and even each dot) using Fruity Effects.

Don't Save!  If you create a masterpiece and you want
to keep it, at least save it under a new name.  We need
you to keep GettingStarted1.flp around so we can use
it to explain some of the more advanced features later.
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channel contains a Generator which could be sample-based or could be a synthesizer plugin.  More on that
later, though.)

1. Open the Channel Settings Dialog.  OK, let's get going and modify the kick drum sample.  Load up
the original version of GettingStarted1.flp again and click on the name "C_Kick" to bring up the
Channel Settings window for that channel (shown in the picture below).

Wait! What's a "sample"? A sample is a little piece of sound stored
in a disk file.  Each channel in Fruity Loops uses a single sample,
usually containing a single note (like a snare drum hit or a single
bass note), but they can also contain entire beats or tunes.  Samples
are usually ".wav" file types, but Fruity supports ".xi" sound files too.

Click Here

Sample
File NameChannel

Selector
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3. Check out the Sample Browser. Another way to load samples is to use the Sample Browser (that's
the other window you see when you first opened Fruity in the "What Are You Lookin' At?" section
above.) This is a special browser for selecting and loading sample and loop files.  To find the C_Kick
sound, click on Packs, then Basic, and then Kicks.  Left-clicking on a sample will play it, right clicking
will open it into the selected channel.  (You select a channel by clicking on the green light to the right
of the channel name as shown above.)

Lost the Browser? No problem.  The five
big buttons on the tool bar shown below
will open and close various windows for
you, including the Browser and the Step
Sequencer.  (Don't worry about those
other windows for now, all will become
clear in the fullness of time…)Click Here

Then Here

Then Here



  
Vol, Pan: These are the
volume and panning wheels
that also appear on the main
screen for each channel.
Turning these will make the
wheels on the main screen
turn as well.
Can't hear the difference?  If you press
and you can't hear any difference in the s
same change on another channel.  For e
change that doesn't affect a kick drum m
difference to the sound of a snare.  If you
difference, stop the loop from playing and
separately by clicking on the wave view w
able to hear the effect better without the

FX 1: A distortion effect

Sine FX: A cheap sine wave
effect.  The first wheel
controls the amount of the
effect, the second controls
the frequency of a sine wave
that interferes with the
sound - try it, it's cool.

Stretch: Specifies exactly
how many dots the sound
should last for.  If it's set to
0, there's no stretching.
(Useful for fitting break
beats.)
FX 3: Makes the pitch of the
sound to change as it plays.  Try
it on the "CHH" sound.
Att, Dec: These control the
attack and  decay.  If you turn
up the attack control, the sound
will take longer to fade in.  If you
turn up the decay, it will fade out
faster.
S.Del: Stereo delay effect.
Amp: Amplifies sample.
Reverb: Echoey effect that
makes it sound like you're
playing in a large room.  A
and B switches between two
different types of reverb.
CUT, RES: Cutoff and
resonance filters.  These filters
produce a really cool effect that
gets used a lot in techno.
Wave View Window:
Shows the shape of the
sound sample. Click here to
hear the sample with all the
effects .  Also a drag and
drop window for loading
samples.
g
pitch of the sample (speeds it up
or slows it down).  The number
indicates how far the pitch wheel
can stretch.  Move it by clicking
and dragging.
15

 a button or turn a wheel
ound, try making the
xample, sometimes a
uch will make a huge
 still can't hear the
 listen the sounds
indow.  You might be

other instruments
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Getting Echo Time Just Right: The "Time" contro
fine-grained to get you just the exact echo you wan
But if you want to echo on the beat, you will have to
look at the Hint Bar while you turn the dial. If you w
the echo every three dots, just turn the dial until the
hint bar shows "3:00".
Pan, Cut, and Res do the
same job as on the sample
panel, but the effects build up
as the echo dies out.

Pitch controls the pitch of the
echo.  If you turn this wheel
right, the echo will get higher as
it dies out.
Feed: Echo volume
(sets how quickly
the echo dies out).
Time: Controls the amount of
time (in dots) between each
echo.  Maximum delay time is
16 dots.
Ping Pong: Makes
the echo flip back
and forth from left to
right (sounds cool
on headphones).
 # Ech: Number of times the

instrument will echo before it
stops.
Arpeggiator: This

gets explained in
the Generators
section of this
guide.
l is
t.

ant
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7. What's an Envelope? An envelope causes a particular parameter to rise, then fall over the life of the
sound. The most classic thing to do is to have a Volume Envelope that makes the sound rise then fall
in volume. But you can also put an envelope on Pitch, Cutoff, and Resonance.  You can get more info
on what all the parameters mean in the On-line Help, but Delay (DEL) sets how much time passes
before you hear the sound, Attack (ATT) sets the fade-in at the beginning, Hold (HOLD) sets how
long the sound lasts at full volume, and Decay (DEC), Sustain (SUS), and Release (REL) control how
the sound fades away.  Play with the wheels and watch the graph change.

8. What's LFO? LFO stands for Low Frequency Oscillation.  It makes a particular effect oscillate up
and down during the life of the sound.  Again, more info is available in the On-Line Help, but Amount
(AMT) sets how much the effect oscillates, Speed (SPD) sets how quickly it oscillates, Delay (DEL)
sets how much time passes before the oscillation starts, and Attack (ATT) sets how quickly the
oscillation ramps up to it's full amount.  Play with the knobs and watch the graph change.

Effect Selector

Envelope

LFO

Set Middle Note

Indicator Light
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10. Why Does the Instrument Panel have More Cutoff and Resonance Controls? It may seem
redundant to have Cutoff and Resonance in the SMP panel and then again in the INS panel, but it's not.
Trust us ☺.  The Cutoff and Resonance here are added in real time rather than statically, so they can
be controlled by the LFO and Envelope on this screen.  (They can also be Live Recorded but that's for
another chapter…) The INS panel cutoff and resonance are also nicer because they allow you to
change the type of filter you use (more on this in the On-Line Help.)

11. Why Can't I Hear the Effect?  Well, if you're still on the Kick Drum from GettingStarted1.flp, it's
going to be pretty hard to hear any LFO effect, although the Envelope might make a difference.  These
effects are more audible on longer samples.  To hear the effects better, go to the Instrument Settings for
the Ins_Round sample and play with the settings now.

Now we're cookin' with gas!
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1. Check out the Graph Editor.  The easiest thing to wrap your mind around is probably the Graph
Editor utility.  First, select a channel to edit by clicking on the channel name, or by clicking on the
green Channel Selector light to the right of the channel name.  Then press the button that makes the
graph editor pop up as shown below.  (Make sure you've loaded up the original version of
GettingStarted1.flp first.)

2. Check out the Effects.  Try clicking-and-dragging the Effect Selector to see which of the various
effects are available.  You should find Pan, Volume, Filter Cut, Filter Res, Pitch, and Shift.  Most of
these effects were discussed previously, in the "Tweaking the Channels" section.  The difference here
is that you can also tweak the value of these effects for each separate dot.  Each bar on the graph sets
the effect value for the single note above (or below) it.  GettingStarted1.flp already has some
tweaking in it.  Check out the Volume tweaks in the CHH channel and the Cutoff tweaks in the
Ins_Square and Ins_Round channels.

Graph Editor
Button

Graph Editor

Effect Selector

Channel
Selector
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4. Try the Volume. You can get instruments to fade in and out over a pattern using the volume graph.
Try this effect on an added snare channel as shown below. (Remember, it's Alt-S to add a channel.
The snare below comes from Packs→→→→Basic→→→→Snares.)  This graph does not center in the middle like
pan, but goes from zero to maximum, with zero at the bottom.  Volume slides like this can sound extra
cool when combined with Cutoff and Resonance slides.  (Hint: to make a smooth line in the graph
editor, right-click on the first bar, then drag the mouse to the right to set the values of all the bars at
once.)
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6. Check out the Melody.  When you play GettingStarted1.flp, that synth melody you hear is being
played on the Ins_Round channel.  To see the notes of the melody, click the Keyboard Editor button
with the Ins_Round channel selected as shown below. What you see now is a vertical piano keyboard
for each dot on the screen.  Hopefully, you have some keyboard skills.  (If not, it's time for some
lessons!) You can change each note by left-clicking one of the buttons on the keyboard. Right-click
turns the note off.

7. Change the Melody.  Now go ahead and change the melody!  You can make it sound how you want,
but below is a suggestion for those who like a note of tension in their music (you can find this melody
in GettingStarted2.flp).  You can use the keyboard editor on any sample - synth, bass, guitar, even
drums.  Have fun!

Keyboard
Editor Button

Keyboard
Editor

Channel
Selector
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1. Check out the Pattern Selector.  Fruity Loops lets you create hundreds of different patterns.  In the
previous sections, we've just been working with pattern 1, but we can access the other patterns either
by changing the number in the Pattern Number box, or by pressing one of the pattern numbers on the
Quickpad (this is a shortcut for quick access to the first 9 patterns.)

             

2. Check out the Playlist. This screen can be opened using the button under the hint bar, or by hitting
F5, or by right-clicking the Song button on the main screen (see above). Try it and you should get a
new window that looks something like below. This window works very much like the pattern view,
except that the dots operate on whole patterns rather than single channels, and you can program
hundreds of dots at a time.  Notice that GettingStarted1.flp consists of pattern 1 repeated 11 times and
pattern 2 once at the beginning.  Make sure Song is selected and press Play.  You should see the Play
Indicator on the playlist start to move, and hear the patterns it is playing.  When it comes to the end of
the dots, it jumps back to the Loop Point and continues playing.  Try moving the loop point (right-
click where you want it to go) and see what happens. (If you press the Pat button, Fruity will just
repeatedly play the current pattern in the Step Sequencer.)

3. What's the Point? Now you can assemble a n
alter melodies, change beats, insert fills, and r
composers use a separate block of patterns for
separately at first, and then piece the song toge

Pattern
SelectorQuickpad

Play Indicator

Loop Point

Patterns
(right-click to
rename)

Song/Pat
Button

Play
Indicator
Bars
23

umber of patterns together to make a song.  This lets you
euse some of the early parts of the song later.  Many
 drums, bass, lead, etc. so they can work on them
ther in the Playlist.
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for this using Alt S)

Pattern 3

Pattern 4

Big deal…
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6. What the Hell is in Pattern 2?  By now you probably checked out pattern 2 and discovered that it
seems to be empty.  Patience, my child.  All will be revealed eventually (but you could experiment
with removing the pattern from the playlist to see what difference it makes…)  We'll talk about what
pattern 2 does in the section on Live Recording.  For now, just enjoy the ride!

Groovy.
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synthesizer plugin in combination with the effects in the Channel Settings dialog. The combination of these
software synthesizers with the sample channels gives Fruity a major power boost!

1. Adding a Synthesizer Channel. To add a channel containing a synthesizer Generator, click on
Channels→→→→Add One as shown below and select one of TS404, 3xOsc, BeepMap, Plucked!,
SimSynth Live, or Wasp.

2. What to Expect. The new channel will appear in the Step Sequencer and the Generator's
Configuration Screen will appear (except for the TS404).  If  the Configuration Screen is small, it
will appear inside a Channel Settings window (3xOsc, BeepMap, Plucked!).  Otherwise, it will appear
as a standalone window (SimSynth Live, Wasp).
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4. Preset Sounds.  All Synth generators have preset sounds available.  You can get to them from the
Presets section of the menu shown above, or by clicking on the little arrows in the top right (see
picture above).

5. The Channel Settings.  All these generators have a Channel Settings window that you get by clicking
on the Channel Name, just like for Sample Generator Channels.  But since each generator is different,
they may not all have all of the panels as the Sample Generators do.  For instance, the TS404 only has
the MISC panel, while the 3xOsc has all of INS, TIME, and MISC.

Preset Sounds

Help
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g , g y
basslines which sound similar to the classic TB-303 machine.

b. 3xOsc. This is a very plain generator that allows you to mix three Oscillators, each of which
generates a tone.  The sounds on their own are not exciting, but they are good raw material to be
combined with INS panel effects and other Fruity Effects (explained in a later chapter).

c. BeepMap.  This is a weird one.  Takes a bitmap image file and turns it into a sound, with strange
and wonderful results.

d. Plucked! A synthesizer that specializes in stringed instrument sounds like guitars, harps,
mandolins, etc.
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f. Wasp. Another full digital synthesizer.  This one is better for creating fast, buzzing, techno-
oriented sounds (hence the name).
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8. Included Plugin Synths.  Of course, we've thoughtfully included a VSTi plugin synth, confusingly
called the DX10, and a DXi plugin synth called the DreamStation.  Note that when you try to load the
DX10, you'll be sent to plugins directory with tons of files.  You're looking for the file named "mda
DX10.dll".  The other files here are all FX Plugins, to be discussed later in the section on Fruity
Effects.
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10. Where Can I Get More? There are literally hundreds of synth plugins out there to download.  Some
of them are free, and some you have to pay for.  Search the web and www.fruityloops.com for good
deals.  One place you should definitely bookmark is www.kvr-vst.com - a huge site with every VSTi
plugin you could possibly want listed.

11. The Arpeggiator. Now that we've introduced the Synth generators, we can finally tell you what the
Arpeggiator section in the Channel Settings window is for.  Open one of the synth channels
(SimSynth Live, for instance) and go to the TIME panel of the channel settings box.  Now click the up
arrow and select a chord.  Now go to a new pattern and place a single SimSynth note and press play.
Instead of a single note, you get a repeating arpeggio.  Cool, huh?  Read more about this in the on-line
help.

Don't deny yourself, dude!  You need all
these generators.  Save up your
squeegee money and buy them ASAP.

Direction of
Arpeggio

Chord Selection

Octave Range

Speed,
Duration, etc.

http://www.fruityloops.com/
http://www.fruityloops.com/
http://www.kvr-vst.com/
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SimSynth

DrumSynth

http://www.mda-vst.com/
http://www.fruityloops.com/
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1. Add a TS404 Channel.  First of all, load up GettingStarted1.flp. Then add a TS404 channel as
shown in the previous section.

2. Copy the Notes from Ins_Round.  That's right, we're going to replace the Ins_Round sample with the
TS404.  First, use the keyboard editor to program the TS404 notes as shown, then click on the
Channel Mute light to turn off the Ins_Round channel and play the result. You may want to turn up
the TS404 Channel a little bit too.

Mute This
Channel

Turn Up
the TS404

Add the
Notes

Umm… I liked it
better before…
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Change the
FX Track (We'll
explain this later)

Add a
Little Echo

Make the Notes
Decay Slower

Make the Sound
Trashier

Last Thing to Do:
Turn these wheels
slowly while the song
plays…

That's a little
better…

You're a Techno god.



  

Oscillator mixing: Turn
the MIX wheel to hear
more or less of oscillator
1 and 2.
The oscillators: You
can have two slightly
different sounds playing
at once.  Click on the
little pictures for different
wave forms.  Set the
octave by turning the
CRS wheel.
LFO: Low frequency
oscillation.  This function
slowly turns a parameter
The Envelope: Attack,
decay, release, sustain,
etc. (Check out the little
picture!)
such as the CUToff up
and down.  Try turning
up the amount (AMT)
and the speed (SPD).
The Filters: Cutoff and
Resonance.  Try the
buttons too (Lo12, etc).
Then try playing with the
buttons to make the
RESonance, tuning
(OSC) and pitch width
Distortion: Turn up both
wheels for a nastier
sound.
35

(PW) oscillate.

Delay: Controls the amount of
echo.

You Wanna Set the Delay? OK,
there's only one delay line for all
TS404 channels. It's on the toolbar
at the top of the Main Window..
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Pitch Bend
Line

New Notes

Can't click off the pitch-bend line?
Try right and left clicking.  One of em's
gotta work!
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Remember when we told you to change the FX Track in the TS404 Channel Settings?  Well now we're
gonna explain what that was all about.

1. Open the Master Effects Screen.  Guess what?  The GettingStarted Loops were using Fruity Effects
all along! Load up one of them and bring up the Master Effects screen by pressing F9 or by going to
View→→→→Effects. You'll get a window like the one below…

2. What You're Lookin' At.  Along the top are the FX Tracks.  You have one Master Track, 16
Regular Tracks, and 2 Send Tracks.  The Master Track is selected by default.  Each track has room
for four FX Plugins.  The Getting Started Loops use the Fruity 7 Band EQ plugin in the Master
Track, and the Fruity Delay and Fruity Reverb plugins in Track 2.  Try changing the track to find the
other plugins.

3. Turn Plugins On and Off.  Just left-click on a plugin to turn it on and off.  Try this with the loop
running to hear the difference.

4. Select Plugins. If you want to add new plugins, click on the arrow where you want to add the plugin
and then choose from the Favorites List or choose Select to choose from the entire list and configure
your favorites.

FX Tracks

FX Plugins

Click Here
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6. Sending Sound to the Plugins. Now we can finally explain what the box in the top right of the
Channel Settings does.  Any effects placed in the Master FX Track will be applied to all the sounds in
the song.  But effects in the numbered Regular FX Tracks will only be applied to the Samples and
Synths which have selected that FX Track in their Channel Settings Dialog.  So, in
GettingStarted5.flp, the Ins_Round and TS404 Channels are sending their sound to FX Track 2,
where Fruity Reverb and Delay will be applied.  The other channels are sending to FX Track 1
(default) which contains no effects.

Right Click
This Bar

Click Here
for Help

Sending to
FX Track 2
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p y
applied to both guitar and drums, but you only had to use a single reverb plugin.

8. Changing Plugins Order.  The order in which you add effects plugins has a huge impact on the way
the final output sounds. Plugins are like guitar stomp boxes.  On each FX track, the first plugin in the
list is applied first, then the output of that plugin is fed to the second, and so on.  To make it easier to
experiment with effects order, Fruity Loops has a simple function to move an effect up or down in the
effects chain. It's on the effects menu shown below (Move Up and Move Down.)

This FX Track
Sends its Output
to Send Track 2
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Fruity Bass Boost. Boost that bass for a super-phat sound.

Fruity Blood Overdrive. Use this to distort channels.

Fruity Center. Use for real time DC offset removal.

Fruity Compressor.  Use this to flatten out the dynamics of the sound.  Apparently Fatboy Slim uses
massive compression to get his drums to sound the way they do…

Fruity Delay. Use for a true echo (not just repeated samples like the channel echo).

Fruity Fast LP. Use for low pass filtering that's CPU friendly (cutoff and resonance).

Fruity Filter. More cutoff and resonance filtering that’s not so CPU friendly.

Fruity Flanger. If you have to ask, you haven't heard it yet.  Real popular among guitar players, this
LFO-type effect can add a cool feel to any song.

Fruity Free Filter. Yet another filter - a classical 12db instead of a state variable filter like the Fruity
Filter (whatever the hell that means.)

Fruity Mute. Use this to mute (silence) channels while live recording.

Fruity Notebook. Keep your song notes here!  This is the plugin used in the Tutorial Loops that came
with your package.

Fruity PanOMatic. Useful for panning the sound back and forth smoothly.

Fruity Phase Inverter. Use to reverse the stereo phase (left and right).

Fruity Phaser. Like the Flanger, but even cooler.

Fruity Reeverb. Use for a much nicer reverb than you can get on the Channel Settings dialog.

mda DX10. This is actually a synthesizer plugin (see the Generators section of this guide).  VSTi
Synth and FX plugins have to live together in the same directory.  You'll just have to remember which
is which.
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11. Getting New Plugins. We gave you a great selection of FX Plugins with your Fruity Package.  But
people are always creating new ones, and you can find many of them on the web.  Some are free and
some cost money.  Surf the web to see what you can find!  Installation is pretty straightforward.  Put
everything into FruityLoops3/Plugins (but if it's a VST plugin, it should go in the VST subdirectory.)
Restart Fruity Loops and your new plugin should appear in the list.

12. CPU Considerations. "WOW!! I can use as many plugins as I want?!?" Actually, no you can’t. Each
plugin you use takes up a certain amount of your computers power. Some take more power than others.
The number of plugins you can use before your computer starts grinding and running out of breath
depends directly on your CPU speed (you know, that Megahertz thing) and also somewhat on the
amount of memory you have. There is no formula for how many plugins you can use, but if the sound
starts breaking up after you add a plugin, it’s a good sign that you’ve gone a few plugins too far.  Don't
forget about the Send Channels, though.  They can help you cut down on the total number of plugins.
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That, my friend, is what we call Live Recording and it's the key to making your songs come alive…

1. Choose an Automation Pattern.  OK, this is important.  Finally, we can tell you what Pattern 2 does
in GettingStarted1.flp.  It's where the Live Recording data is stored that moves the Ins_Round and
Ins_Square cutoff wheels.  The only way to not tie yourself completely in knots over where you stored
your Live Recording data is to always have one pattern where you do all your Live Recording.  For
this song, it happens to be pattern 2.  Then you need to place that pattern in the Playlist at the
beginning of the song to play back the live tweaking.  As you learn more about what you are doing,
you can break out of this mold, but you need to start simple.

Click the INS Tab

Watch this
Wheel Move!

Remember to Select the Right
Pattern During Live Recording!
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3. Set the Buffer Length low.  You may have noticed that there is a short delay between your tweaking
and Fruity's response.  That's controlled by the buffer length (hit F10 and select the Wave tab).  The
lower you set this slider, the faster Fruity will respond.  But don't set it too low, or the sound will be
choppy (see the "What are You Lookin' At?" section).

4. Important Note. When you've got the Recording Switch on and the loop is playing, moving a wheel
will erase over all the previously recorded tweaks from that point in the song until the end.  This can be
frustrating, so often it's best to get the recording approximately the way you want it and then make
further changes in the Event Editor described in the next section.

5. What can be Recorded? Most wheels and sliders are recordable, including those that control Plugins.
But some controls aren't recordable.  The quickest way to tell what's recordable is to mouse over a
control and look for the red dots in the Hint Bar.  If these dots appear, then you can record that control.

Record SwitchSong Mode

Red DotsDescription

Plugins.  You can do live recording on
most Plugins, but not all of them.
Experiment to find out.
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LemonBoy's Live Recording Advice…

•  Always, always, always check the pattern selector before you start
recording!!!

•  Try to get your song laid out the way you want it before you start live
recording.  Once you have events recorded, it is difficult to change the
layout of the playlist in a way that will still sound good.

•  Always save a backup copy of your loop before you start any live
recording.  That way if you mess things up or change your mind, you
can go back to the clean copy.

•  Save your loop frequently during live recording.  If you accidentally
tweak something and erase some events, you can always go back to
the previous version.

•  Get yourself an External MIDI Controller to make your life easier (See
the section on External Controllers for more info!)
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move a wheel during a recording session, the new setting is stored as an "event" for that wheel at that
moment in the loop.  With the event editor, you have complete control over how the sound is tweaked
during playback.

1. Record Some Live Tweaking on a Particular Wheel.  The cutoff on the TS-404, for instance.  Let's
assume you already did that in the previous section.  If you prefer you can look at the event editor for
the INS Cutoff Wheel in GettingStarted1.flp for either the Ins_Round or Ins_Square sample.

2. Stop Fruity and Open the Event Editor.  Right-click on the wheel you modified, and select Edit
Events from the pop-up menu.  The screen you are looking at now is a lot like the Graph Editor
described earlier.  One difference is that this graph controls the level of a single wheel or slider at a
particular point in the song.  (OK, it's actually more complicated than that.  Remember how we told
you to keep all your live recording in a single pattern (Pattern 2) and place this pattern once at the
beginning of a song?  If you do that, then the bars in the Event Editor will match the bars in the
Playlist.  If you don't do that, you're on your own!) The other main difference is that this graph is used
to set Events (bright vertical lines corresponding to the value of the wheel you are setting) that persist
until the next event.

Edit mode
selection

Edit menu Play Indicator Mouse Cursor
Shows Edit Mode

Events
(Each sets the level
until the  next event)
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b. Delete Mode.  Click on the delete symbol  to change to this mode.  You can delete events by
clicking on them, or click and drag to delete a series of events.  (The events are the bright vertical
lines on the main window.)

c. Smooth Mode.  Click on the smoothing (interpolation) symbol  to change to this mode.  You
can click and drag to highlight a region.  When you let go of the mouse button, the events will be
smoothed out, instead of looking choppy.  Try it!

d. Select Mode.  Click on the select symbol  to change to this mode.  When you click and drag,
you will see a red region highlighted on the Play Indicator Bar.  You can also right-click on the
Play Indicator Bar in any mode to expand the highlighted region.  You can cut and zoom to this
region from the Edit Menu.

4. Miscellaneous Facts.  Here's some stuff you should know about the Event Editor.

a. Undo. There is a limited form of undo available for the Event Editor.  Use CTRL-Z to undo the
last action.

b. Setting the Initial Event. You will notice that after live recording, the wheel you recorded
sometimes doesn't start in a sensible place when you play back the loop.  This can be fixed by
turning the wheel to a good start position, and then right-clicking the wheel and selecting Init
Events With This Position. This sets the very first event so that the wheel will always start where
you want it.

c. Getting a Feel for It. It takes some practice to master the event editor, and to be able to get a song
to sound exactly the way you want it, but it's definitely worth it.  Keep practicing until you get it
right!

d. Live Recording Defeats Static Tweaking.  If a wheel has some events recorded on it, you can no
longer just set it anywhere you want and expect it to stay there.  You have to go through the Event
Editor or start a new live recording session to change it.
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6. Using the Event LFO. Open the event editor for some control (perhaps the Channel Settings INS
Panel Cutoff for Ins_Round in GettingStarted1.flp).  Make sure you're on the right pattern in the
pattern selector (pattern 2 for GettingStarted1.flp).  Now select an area to oscillate using Select Mode
or by right-clicking on the Play Indicator Bar.  Now hit ctrl-l or select LFO from the Edit Menu .
This will pop up the LFO Settings window and immediately apply the LFO to the selected area.  See
below for an example.

7. Play with the Main LFO Settings.  Notice the dialog has three sections.  If you play with the controls
in the Start and Shape sections, you should be able to create all kinds of cool effects.  In the Start
section, you can alter the value (height), range (depth), and speed (length) of the waves.  In the Shape
section you can alter the shape of the wave (sine wave, saw-tooth, or square) and the phase (basically
moves the waves left and right.)

horizontal position
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9. What Else is in the Edit Menu?  In the Edit Menu you can also delete all events (Edit→→→→Delete All),
select all events (Edit→→→→Select All), and change the color and look of the editor (Settings).  You can
also turn Snap on and off. Use Snap to make sure your highlighting and event placement is always
right on a beat or bar.  The grain of Snap can be changed on the main toolbar (see below).  Try the
different settings to see how it effects highlighting and event placement  The finest grain is Tick,
which will cause you to snap to extremely fine-grained locations between notes.  If you select Auto,
then Fruity will decide for you where the best snap location is.

Time for more tips

•  You can undo an LFO with Ctrl-Z.

•  If you record tempo changes, the delay line for the TS-404 will
automatically be reset at every change.  The delay lines for the
sample channels will not, but the delay length will change with
the tempo, making it sound a little weird at first.

Snap Toolbar
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can't do that with any other type of channel.  The Piano Roll solves all of those problems!

1. Open the Piano Roll Editor.  Load up GettingStarted6.flp and select pattern 3.  Notice that the Step
Sequencer view is very different.  That's because the Ins_Round and Ins_Square channels contains
Piano Roll data instead of normal dots.  You can open the Piano Roll Editor for either channel either
by right-clicking the channel name or by left-clicking the Mini Piano Roll.  Open it for the
Ins_Round channel.

2. What You're Looking At.  First thing to notice is that this screen looks a little like the Event Editor.
See the Play Indicator Bar, the Edit Mode Buttons, and the Edit Menu Button?  But the "events" in
the Piano Roll are notes to be played at the given location, rather than level settings for various Fruity
controls.  Each horizontal green line shows where a note should start and end, and the Piano
Keyboard on the left shows the pitch of each note.  The note labeled below is a B4 (B in the 4th

octave) which will start on the second beat of the first bar and play for 3/4 of a beat.

Left Click Here
(Mini Piano Roll)

Right Click Here
(Channel Name)

Edit Menu Edit Mode
Buttons

Play
Indicator

Mouse
Cursor

B4
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4. Important Advice.  Before we go any further, here's a tip.  Make sure you always keep your Piano
Roll patterns separate from your regular patterns.  You'll just avoid a lot of confusion that way.  You
don't have to do it this way, of course, but even the simple song in GettingStarted6.flp would not
have been possible if we had merged patterns 1 and 3.  For homework , see if you can figure out why
that is!

Man, this thing just
keeps gettin' better!
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may not actually last as long as you wanted them to.

6. Basic Piano Roll Editing.  Here's a run-down of how to edit your melody line.

a. Entering Notes.  This can get a little tricky.  To enter a note, make sure you're in Draw Mode by
clicking the Draw Mode Button (see the Event Editor section), click on the canvas, and drag the
note to where you want it to start.  If the loop is not playing, you should hear the note you are
entering as you drag it around. The length of the note will match the length of the last note you
placed.  To change the length, grab the right hand side of the green bar and drag it.

b. Note Snap.  You may find the note snaps to a place you didn't want it to go.  If so, change the
Snap Level on the main toolbar the same way as you did for the Event Editor (see previous
section).  Sometimes you just can't get the note length to snap where you want no matter what you
do.  In this case, shrink the note to the left as far as you can and then drag it out to the right again.
This often fixes the problem.

Using
Loop
Points

Loop
Points
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Delete Mode with the Delete Mode Button (see the Event Editor Section).

e. Undoing Changes. Like the Event Editor, there is a limited undo available from the Edit Menu
or by pressing Ctrl-Z.

f. Cutting, Copying and Pasting Notes.  Go into Select Mode with the Select Mode Button (see
Event Editor section) and click and drag to highlight some notes.  Then use the Cut, Copy and
Paste options in the Edit Menu or use Ctrl-C, Ctrl-X, and Ctrl-V.  Pasting can get a little tricky,
though.  The notes will paste to their identical locations in the first bar that is currently displayed
on the screen.  So to paste from bar 1 to bar 2, select the notes in bar 1 and hit Ctrl-C to copy, then
scroll over to bar 2 and hit Ctrl-V.  If the notes don't appear, they probably went into bar 1.  Press
Ctrl-Z to undo and try again.

7. Chords and Harmonies.  One of the really nice features of the Piano Roll is that you can have notes
sound on top of each other to create chords and harmonies.  Here, we're getting into sophisticated stuff
that you need some kind of musical intuition for, but Fruity does make life a little easier by giving you
a Chord option on the Edit Menu.  Select the type of chord you want, and then go into Draw Mode.
You can now drop entire chords onto the canvas.  GettingStarted7.flp is an example of a polyphonic
melody.  The picture below is the Ins_Round Piano Roll after zooming in on the entire Piano Roll.

Overlapping
Notes
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Roll in pattern 4 that uses slides.  Check it out.

9. Tweaking the Notes.  Remember the Graph Editor from way back in the Step Sequencer section?  It
let you individually change Volume, Cutoff, Resonance and so on for each note.  The Piano Roll has a
similar function, laid out in the bottom part of the Piano Roll Editor.  Every time you enter a note, you
get a spike in the bottom graph that shows the level of the parameter selected by the drop down box on
the left (labeled Event Select above).  After you enter the notes, you can change the values of any of
the parameters by grabbing the top of the spikes and dragging them. GettingStarted8.flp has volume
tweaks in the Piano Rolls for both pattern 3 and 4. You can set Velocity (=Volume), Pan, Cutoff, and
Resonance.  As an added bonus, you can also use this graph as the Event Editor for Channel Pan,
Pitch, and Volume.

10. Importing MIDI Tunes.  In the Edit Menu under MIDI, you'll find two methods of importing MIDI
sound files directly into the Piano Roll Editor. There are tons of MIDI files for various popular
melodies floating around out there.  Now you can suck them directly into Fruity Loops and use them in
your songs.  How cool is that?

Slide
Icon Note

Starts

Slides
Up

Slides
Down

Then
StopsVolume

Tweaks

Event
Select

That's it, for the Piano
Roll.  Go make some
beautiful  music!
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can still get a good idea of the awesome power of the software this way.  Here's how you do it…

1. Select Import→→→→Beat to Slice from the File menu.

2. Select a Beat.  The first thing you'll be asked to do is select a wav file to slice.  Make sure it's at least a
1 bar (1 pattern long) beat.  You can slice a file that's not a beat, but it won't work very well…

3. Set the BeatSlicer Parameters.  After you've selected the beat, you'll get the dialog box shown below.
First select the number of patterns (bars) you want the beat to span by clicking and dragging.  If you
want the beat sliced and imported directly into Fruity Loops, hit the check mark.  If you want to use the
BeatSlicer editor, check Use Standalone Editor first.  (The editor has it's own help system to explain
things.)

4. Store the Sliced Beat.  Next, a dialog will ask you to select a directory to store the sliced up pieces of
the original beat file.  The default is the Fruity Loops Sliced Beats directory.

5. Save Changes to your Loop.  This process drastically alters the current loop, so the next dialog asks
you if you want to save it before continuing.

6. To Merge or Not To Merge.  Final question - do you want to merge the beat with the current project?
If you say yes, one channel per sliced up beat will be added to the end of your channel list, and the beat
will be inserted into the first few patterns of your song.  Because of this, you should probably insert
some blank patterns at the start of the song before you slice.  You can do this with ctrl-shift-insert in
either the Playlist or the Step Sequencer.

7. Weirdness. You should also know that the BeatSlicer considers a bar to be 16 dots, regardless of how
many dots you have per pattern.  So if your patterns are 32 dots wide and you select to merge with the
current loop, selecting 1 bar in the dialog above will put the beat into the first half of the first pattern.
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Importing ReBirth RB-338 Songs. You might have noticed
this option in the Import Menu...  This feature allows you to
open a ReBirth song, configure it to Fruity Format, and listen
in Fruity Loops. Of course, it's not a perfect conversion - see
the pop-up window for details about what parts of the song
might not be converted properly.  The playlist and pattern
layout also needs some explaining.  The first 32 patterns are
TB303 #1.  The next 32 are TB303 #2.  Then you have 32
patterns for the TR808 and another 32 for the TR909 for a
total of 128 patterns.  Of course most of these will probably
be blank for any given song, so your song ends up pretty
spread out, but it's all there if you hunt for it.
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1. Export to Wav or MP3. This option is available from the File menu. Whether you choose Wav or
MP3, you will be asked to specify the name of the file and then the dialog below will appear.  There's a
lot to choose from here, and we're not gonna go into it.  If you want an explanation of every button, go
to the on-line help under File Formats.  It's all there.  If you want to just get your song rendered, leave
the settings the way they are (trust us - we picked the defaults for a reason!)

2. Should I Use Wav or MP3?  Wav is a raw sound file format.  Huge files, excellent sound quality
(expect to use about 10 MB per minute depending on Depth).  Wav files are suitable for burning onto
CD.  MP3 is a compressed format.  Smaller files, but sound quality may be slightly compromised
(expect to use about 1 MB per minute depending on Bit Rate).  If you want to share files on the
internet, MP3 is the way to go.

3. Should I Use "Background Rendering?"  Rendering can take a long time and hogs the CPU,
especially if you choose the high-quality options in the Quality section of the window above.  But if
you click on Background Rendering, Fruity will iconify itself and continue to render unobtrusively in
the background.  It takes longer, though.

Dude!  That looks
complicated…
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music in MP3 format for free.  www.mp3.com is probably the best known site, but it's easy for an
amateur looper to get buried there in all the high-profile commercial stuff.  www.traxinspace.com is
an option if you are more interested in feedback from other musicians.  The site is a musical
community with people like you reviewing every song that is placed on the site.  It's a great way to get
feedback.  If you don't like either of these options, you can always create your own site using one of
the many free hosting services out there.  Good luck!

Now go get that
record deal!

http://www.mp3.com/
http://www.traxinspace.com/
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on the controller to do (a minor inconvenience for the luxury of changing both cutoff and resonance at the
same time!)  Each knob on the controller can be linked to a different wheel or slider on Fruity Loops.  If
you have a controller, this section will tell you how to make it work with Fruity.  If you don't have one, get
one!  First we'll introduce a few of the more popular controllers, and then we'll tell you how to set them up.

1. A Few Examples of MIDI Controllers.    

a. The PhatBoy. The PhatBoy is one of the most affordable (hence most popular) MIDI controllers,
made by KeyFax at www.keyfax.com.  It's small, with only 13 knobs, but that's as big as most
people will ever need (you've only got two hands!).

Who you
callin' phat?

http://www.keyfax.com/
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         ♥ The Boss♥

c. The MC-505.  The MC-505 by Roland (www.rolandgroove.com) is a lot more than a MIDI
controller.  It's a hardware synthesizer and sequencer specially built to replicate classic techno
sounds like the TB-303, TR-808 and TR-909.  But it also has full MIDI controller capabilities, so
you can link some of the knobs to Fruity controls.

Drehbank.  They are
not for manual writers!

Whoa!  Talk about
bringin' a gun to a
knife fight!

http://www.doepfer.de/
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pin trapezoidal joystick port.  If you have the round connectors, you need a cable to go from
"MIDI Out" on your controller to "MIDI In" on your computer.  If you only  have a game
controller connection, you'll need a special cable that has two round MIDI plugs at one end and a
trapezoidal plug at the other.  Both these types of cables should be available at any music store
specializing in keyboards and synthesizers (but if you ask for them in a computer store, you may
just get blank looks.)

b. Turn on the Controller and Start Up Fruity Loops. If you have a PhatBoy, make sure the
power switch is set to mode "III".  If you have a DrehBank, hold down the "Bank 1" button when
you plug in the power cable.  For the MC-505, make sure the MIDI mode is set to MODE 2 (Shift
12, Edit TxRx = Mode2). Try turning the knobs on your controller.  If everything is ok, you
should see a little red "Midi" light flash beside the Hint Bar of Fruity Loops every time you turn a
knob.  If that works, great!  You can skip steps c to e.  If not, read on my friend.

c. Enable MIDI Remote Control. Check the Options menu to see if there is a check mark beside
MIDI Remote Control. If not, click on it and see if you get the light now.  If not, read on.

           hERETIC

Sam: Yo, check it out. I need a cable with
MIDI connections on one end and a joystick
plug on the other.

Computer Store Guy: What's mee dee?

Tha Little
Red Light
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e. Troubleshooting Checklist.  If the red light is still not coming on when you turn the knobs on
your controller, here's a list of things you should check.

•  Did you select the correct PhatBoy or DrehBank mode in step b?
•  Did you enable "MIDI Remote Control" in step c?
•  Did you select the correct MIDI input in step d?
•  Are your MIDI In and Out cables reversed?
•  Did you plug the controller into a power outlet?

       Jaha

Are you
ready to
rock?

If your Midi controller seizes up on ya… Try
this as a last resort: quit Fruity, then select
Programs→→→→Fruity Loops→→→→Advanced→→→→Reset
settings from the Windows Start menu.  Then
relaunch Fruity and try again…
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b. Turn a Knob on Your Controller.  You should see the Channel and Controller numbers
change.  Now click OK, and turn the same knob.  You should see the volume control turn back
and forth and hear the volume of the instrument change.  You're in business!

c. Set the Buffer Length as Low as You Can.  Earlier, we explained the buffer length slider (get to
it by hitting F10 and clicking the Wave tab).  This slider determines the delay time between you
turning a knob and the sound of Fruity changing.  So you want to set it low.  But if you set it too
low, the sound will become choppy.  So try to find a happy medium.  If you can't get it low
enough to do what you want, then I guess you need a faster computer. Sorry, dude.

4. Which Controls Can I Link? Pretty much all of them, actually.  For reference, though, it's the same
set of controls that can be changed in Live Recording.  Again, if you want to know whether a control
can be linked externally and live recorded, mouse over it and look for the two red dots in the Hint Bar.
That's it.  Happy looping!
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www.mp3.com/gol
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SimSynth 1 & 2 Renderers
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DrumSynth Renderer
Paul Kellet
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Peter Segerdahl
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Vassilatos Vangelis (sorcer)

www.soundclick.com/praetorsdream
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Sam Scott (hERETIC)
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(More complete credits
in the product itself.)

A big round of applause for the
Fruity Loops team!

http://www.mp3.com/gol
http://www.soundclick.com/praetorsdream
http://www.mp3.com/hERETIC
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3xOsc, 26, 27, 28

A
amount (AMT), 17, 18, 35
arpeggiator, 16, 31
attack (ATT), 15, 17, 35
automation, 5, 25, 42, 43, 46, 62

B
background rendering, 56
BeatSlicer, 54, 63
BeepMap, 26, 28
bit rate, 56
browser, 9, 14, 32
buffer length, 43, 45, 62

C
channel settings, 13, 15, 16, 21, 26, 27, 31, 34, 35, 37,

38, 40, 42, 43, 47
instrument panel, 17, 18, 21, 27, 28, 42, 45, 47
misc panel, 17, 27
sample panel, 15, 18

choppy sound, 8
chords, 31, 49, 52
chorus, 37
cut itself, 22
cutoff & resonance, 15, 16, 17, 18, 19, 20, 21, 35, 40,

42, 43, 45, 47, 53, 58

D
decay (DEC), 15, 17, 35
delay (DEL), 17
delay (echo), 16, 17, 20, 35, 37, 38, 39, 40, 43, 62
depth, 47, 56
discussion forum, 10
distortion, 15, 35
dots, 11, 12, 19, 21, 23, 25, 43, 49, 54, 62

DrumSynth, 32, 63
DX10, 30, 40
DXi Wrapper, 30

E
echo (delay), 16, 17, 20, 35, 37, 38, 39, 40, 43, 62
envelope, 17, 18, 35
environment settings, 8, 9
Equalizer, 37, 39, 40
event editor, 5, 43, 45, 46, 47, 49, 50, 51, 52, 53
events (initial), 46
export, 56, 57

F
FAQ, 10
Fatboy Slim, 40
feed, 16
flanger, 37, 40
Fruity effects, 5, 12, 28, 30, 37
fx 1, 15
fx 3, 15
FX Tracks, 5, 37, 38, 39

G
Getting Started Loops, 10, 37

GettingStarted1.flp, 10, 11, 13, 16, 18, 19, 20, 21,
23, 24, 33, 42, 45, 47

GettingStarted2.flp, 21
GettingStarted3.flp, 25
GettingStarted4.flp, 34, 36, 62
GettingStarted5.flp, 36, 38, 43
GettingStarted6.flp, 49, 50
GettingStarted7.flp, 52
GettingStarted8.flp, 53

graph editor, 19, 20, 21, 45, 53, 55
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I
import, 53, 54, 55
initial event, 46

J
Jaha, 61

K
keyboard editor, 21, 33

L
Lemon Boy, 5, 9, 10, 12, 13, 14, 15, 16, 18, 24, 25, 31,

33, 34, 35, 36, 43, 44, 48, 50, 53, 55, 56, 57, 58, 59,
61, 63

LFO, 17, 18, 35, 47, 48
live recording, 40, 45, 46
loop point, 23, 25, 51

M
main window, 9, 10, 46
MC-505, 59, 60
menu bar, 10
MIDI

cables, 60
controllers, 58, 59, 60, 61, 62
drivers, 8
files, 53
settings, 61

mixing buffer, 8
MP3, 56, 57, 63

O
on-line help, 5, 10, 15, 17, 18, 28, 31, 40, 56, 63
oscillator (OSC), 28, 35
oscillators, 35

P
pan, 12, 15, 16, 17, 19, 20, 40, 53
pat/song, 23, 24
pattern selector, 23, 24, 47
phaser, 37, 40
PhatBoy, 58, 60, 61
piano roll, 5, 49, 50, 51, 52, 53
ping pong, 16
pitch, 5, 15, 16, 17, 19, 21, 36, 49, 53
pitch bend (slide), 5, 20, 36, 49, 53
pitch witdth (PW), 35
play indicator, 23, 46, 47, 49
play switch, 9, 11
playlist, 5, 23, 25, 42, 45, 50, 54
Plucked!, 26, 28
plugin, 5, 13, 26, 30, 31, 37, 38, 39, 40, 41
polling, 8
presets, 27, 32, 41

R
ReBirth, 55
registration, 6, 7
release (REL), 17, 35
remote control input, 61
resonance & cutoff, 15, 16, 17, 18, 19, 20, 21, 35, 40,

42, 43, 45, 47, 53, 58
reverb, 5, 15, 37, 38, 39, 40
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38, 40, 45, 47, 49, 51, 57
shift, 19, 21, 55, 60
shortcuts, 10, 23
SimSynth

Live, 26, 29, 31
standalone, 32

sine fx, 15
slide (pitch bend), 5, 20, 36, 49, 53
snap to grid, 48, 51
SoundBlaster, 8
speed (SPD), 17, 35
speed (tempo), 55
step sequencer, 9, 11, 22, 23, 26, 49, 53, 54
stereo delay, 15
stretch, 15
sustain (SUS), 17, 35
synth channels, 31

T
TB-303, 28, 55, 59
tempo, 55
tick, 48
tool bar, 9, 48, 51
TR-808, 55, 59
TR-909, 55, 59
troubleshooting, 61
TS-404, 26, 27, 28, 33, 34, 36, 37, 38, 43, 45, 47, 49,

51, 62, 63
tutorials, 10, 40

U
undo, 46, 48, 52

W
Wasp, 26, 29
wav

export to wav, 56
files, 54

weblogin.url, 6
Windows, 7, 8
www.FruityLoops.com, 2, 7, 10, 31, 32
www.mp3.com, 57, 63
www.TraxInSpace.com, 57

Z
zipped loop packages, 57
zoom, 46, 52
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